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Introduction

Introducing Cortona® Movie Maker

Cortona Movie Maker is easy-to-use software for capturing video and creating
screenshots from interactive animated 3D scenes written in VRML. It records video
files of screen actions performed in the 3D View window and saves them as standard
AVI or other popular video formats. The video file may be compressed by some
common video codecs that are included with Windows or supplied by third parties.
Cortona Movie Maker works on all major Windows Operating Systems and gives
excellent results in producing smooth top quality video or hi-resolution images.

The video you record and screenshots can be used in many ways:

Demo CDs

If you do not want to distribute VRML models of products on CDs why not convert them to video. The
video is recorded on a CD and can be run on any computer without the need to install additional
software.

Video training courses

Although interactive Virtual Manuals are very effective training tools, videos can sometimes be more
suitable for certain needs. With Cortona Movie Maker there is no need for specialist film equipment as
Virtual Manuals can be easily and quickly converted to video.

Video spots

When 3D models have to be included in video spots there is no need for additional formats
conversation. Files created with Cortona Movie Maker can be easily inserted into video or TV spots.

Polygraphy

Resulting resolution of a screenshot can be higher than the screen resolution, for example, 4000x4000
against 640x480 pixels. This makes images suitable for high quality polygraphy.

Cortona Movie Maker Features

Cortona Movie Maker includes features that offer the user more convenience and the ability to work more
quickly. Some of these features include the following:

Input formats: VRML97, VRML 1.0

Cortona Movie Maker captures video and makes screenshots or sequences of images from 3D scenes in
VRML97 format (VRML 1.0 objects can be imported with the help of Cortona VRML 1.0 Converter
(http://www.parallelgraphics.com/products/cortona/converter/).
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Video output formats: AVI movies, QuickTime movies, Windows Media and RealMedia

Video files are encoded and compressed with different codecs that come with Microsoft® Windows® or are
supplied by third parties.

Image output formats: Portable Network Graphics, JPEG and Windows Bitmap images

The appropriate quality and encoding settings can be set for each graphics format.

Interactive and animated VRML scene capture

Cortona Movie Maker is capable of handling 3D models that contain both animation and interactivity. All the
interaction actions performed by the user are also captured.

Ability to include the mouse pointer

The mouse pointer can be captured along with the screenshots or video.

Ability to edit a scene with VrmlPad

The stopped scene can be edited with VrmlPad (http://www.parallelgraphics.com/products/vrmlpad) and
reloaded to immediately see the changes.

Antialiasing filter

The antialiasing filter can be switched on to get smooth-edged pictures and video.

Recording can be automatically paused until all resources are loaded

To avoid capturing white spots instead of the large long-loading textures Cortona Movie Maker pauses
recording until such resources are loaded.

Custom watermarks

Any GIF or PNG image can be placed over the movie or screenshot as the watermark with a different
transparency level.

Removing Cortona Movie Maker

To remove the Cortona Movie Maker program:

1. Click the Start button and then point to Settings.

2. Click the Control Panel and then double click the Add/Remove Programs icon.

3. In the dialog box select Cortona Movie Maker and click the Change/Remove button.

4. Click Next if you want to remove the Cortona Movie Maker installation completely. Click Cancel if you
decide to keep Cortona Movie Maker.

Note

The Wise uninstaller program deletes all the standard Cortona Movie Maker components and registry entries.
You must manually remove any shortcuts to Cortona Movie Maker that you may have created elsewhere.
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About VRML

The Virtual Reality Modeling Language (VRML) is a file format for describing interactive 3D objects and
worlds. VRML is designed to be used on the Internet, intranets, and local client systems. VRML is also
intended to be a universal interchange format for integrated 3D graphics and multimedia. VRML may be used
in a variety of application areas such as engineering and scientific visualization, multimedia presentations,
entertainment and educational titles, web pages, and shared virtual worlds.

Design Criteria

VRML has been designed to fulfill the following requirements:

Authorability

Enable the development of computer programs capable of creating, editing, and maintaining VRML files, as
well as automatic translation programs for converting other commonly used 3D file formats into VRML files.

Composability

Provide the ability to use and combine dynamic 3D objects within a VRML world and thus allow reusability.

Extensibility

Provide the ability to add new object types not explicitly defined in VRML.

Implementability

Capable of implementation on a wide range of systems.

Performance

Emphasize scalable, interactive performance on a wide variety of computing platforms.

Scalability

Enable arbitrarily large dynamic 3D worlds.

Characteristics of VRML

VRML is capable of representing static and animated dynamic 3D and multimedia objects with hyperlinks to
other media such as text, sounds, movies, and images. VRML browsers, as well as authoring tools for the
creation of VRML files, are widely available for many different platforms.

VRML supports an extensibility model that allows new dynamic 3D objects to be defined and a registration
process that allows application communities to develop interoperable extensions to the base standard. There
are mappings between VRML objects and commonly used 3D application programmer interface (API)
features.

Scope

The VRML specification defines a file format that integrates 3D graphics and multimedia. Conceptually, each
VRML file is a 3D time-based space that contains graphic and aural objects that can be dynamically modified
through a variety of mechanisms. VRML defines a primary set of objects and mechanisms that encourage
composition, encapsulation, and extension.

The semantics of VRML describe an abstract functional behavior of time-based, interactive 3D, multimedia
worlds. VRML does not define physical devices or any other implementation-dependent concepts (e.g.,
screen resolution and input devices). VRML is intended for a wide variety of devices and applications, and
provides wide latitude in interpretation and implementation of the functionality. For example, VRML does not
assume the existence of a mouse or 2D display device.
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Each VRML file:

•  implicitly establishes a world coordinate space for all objects defined in the file, as well as all objects
recursively included by the file;

•  explicitly defines and composes a set of 3D and multimedia objects;

•  can specify hyperlinks to other files and applications;

•  can define object behaviors.

An important characteristic of VRML files is the ability to compose files together through inclusion and to
relate files together through hyperlinking. For example, consider the file earth.wrl which specifies a world that
contains a sphere representing the earth. This file may also contain references to a variety of other VRML
files representing cities on the earth (e.g., file paris.wrl). The enclosing file, earth.wrl, defines the coordinate
system that all the cities reside in. Each city file defines the world coordinate system that the city resides in
but that becomes a local coordinate system when contained by the earth file.

Hierarchical file inclusion enables the creation of arbitrarily large, dynamic worlds. Therefore, VRML ensures
that each file is completely described by the objects and files contained within it and that the effects of each
file are strictly scoped by the file and the spatial limits of the objects defined in the file. Otherwise, the
accumulation of files into larger worlds would produce unscalable results (as each added world produces
global effects on all other worlds). For example, light sources have the potential of global effect since light
energy theoretically does not dissipate to zero. And, if the earth file contains 100 city files each containing
100 lights each affecting all objects in the world, the lighting calculations would quickly become intractable.
Therefore, in order to prevent global effects, light source objects are scoped by either a maximum radius or
by location within the file.

Another essential characteristic of VRML is that it is intended to be used in a distributed environment such as
the World Wide Web. There are various objects and mechanisms built into the language that support multiple
distributed files, including:

•  in-lining of other VRML files;

•  hyperlinking to other files;

•  using established Internet standards for other file formats;

•  defining a compact syntax.

See also

http://www.vrml.org/Specifications/VRML97/

Ordering Information

You are free to evaluate the demo version of Cortona Movie Maker 1.0 for a period of 30 days before you are
required to purchase the program.

You can order Cortona Movie Maker from the online software shops or directly from ParallelGraphics and its
local distributors.

You can find more information about ordering Cortona Movie Maker at the ParallelGraphics Web site:
http://www.parallelgraphics.com/products/moviemaker/order/

If you have any questions, please contact us at sales@parallelgraphics.com
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Copyright Notice

Copyright© 2000-2002 ParallelGraphics. All rights reserved. ParallelGraphics is a registered trademark of
ParallelGraphics Ltd.

DirectX, Microsoft, Windows, Windows Media, and Windows NT, are either registered trademarks or
trademarks of Microsoft Corporation in the U.S. and/or other countries. Certain other product names, brand
names and company names may be trademarks or designations of their respective owners.
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Getting Help

Getting Assistance

You can get help without interrupting your work.

For a brief description of a menu command:

Position the pointer over the command. The description appears on the Status bar.

For a description of a toolbar button:

Position the pointer over the button. The name appears below the button.

For a context-sensitive help in a pop-up window:

Click the question mark button and then click anywhere in the dialog box. A pop-up help topic provides
information about the user interface element that was clicked.

Technical Support

We are interested in receiving your comments and suggestions about Cortona Movie Maker. For product
support send an e-mail to support@parallelgraphics.com. Before posting your message, please follow these
simple instructions:

Check the online Help.

Include in your message any information that could help answer your question or solve the problem.

Document the system configuration: OS version, CPU type, memory, sound card, graphics card, monitor, etc.

When error messages occur please document the complete message including sub-dialog details and
provide step-by-step instructions for reproducing the problem.

ParallelGraphics Web Site

Visit http://www.parallelgraphics.com on the World Wide Web for the latest information on our company,
future product releases and as a central location for visiting other 3D spaces.
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Using Cortona Movie Maker

Open an Existing Scene

File menu > Open

To open a VRML scene from a specified file:

1. Click the Open button on the Standard toolbar or choose Open from the File menu.

2. In the Files of type box, select the VRML Files item.

3. In the Look in box, click the location of the file.

4. Below the Look in box, double-click the folder you want.

5. Double-click the file name, or type it in the File name box.

6. A chosen scene is opened and is shown in the 3D View window.

Note

You can also open an existing scene by dragging its file onto the title bar of Cortona Movie Maker.

Opening a VRML file from the Web

File menu > Open URL

To open a file from the Web:

1. From the File menu, choose Open URL.

2. Type the valid Internet address (URL) of your file in the text box, or use the drop-down list to select
previous URLs. When you select an URL in this list, the URL appears in the text box.

3. Click OK.

Note

You can also open a scene by dragging an Internet shortcut from your Web-browser onto the title bar of
Cortona Movie Maker. The animated globe in the Status bar at the bottom of Cortona Movie Maker indicates
the scene is loading.

Using menus

You can use the Cortona Movie Maker commands by choosing the appropriate commands from the menus.
The Cortona Movie Maker has a standard Windows menu with pull-down menus for several categories of
commands. Some menu commands duplicate the buttons in the toolbars.



Using Cortona Movie Maker > Using menus

8

File

Provides standard file-interaction commands (Open, Export Image), as well as commands for exporting files.
It also provides quick access to the files you last opened. 

Command Button Purpose

Open Opens an existing VRML scene.

Open URL Opens the VRML scene from the Web.

Import Screen
Saver Scene  

Opens the VRML scene used in the playlist of the ParallelGraphics Screen
Saver. If the Screen Saver in not installed on the computer, the command is
inactive.

Export Image Saves the image of the current frame.

The Most-
Recently Used
List

 
Contains the names of the scenes that have been opened most recently by
Cortona Movie Maker.

Exit  Exits the program.

Edit

Editing the currently opened VRML scene and setting Cortona Movie Maker options.

Command Button Purpose

Copy Copies the image of the current frame onto the Clipboard

Edit with
VrmlPad  Opens the currently opened scene in ParallelGraphics VrmlPad if it is installed on

the computer.

Options
 

Opens the dialog that contains the options for the movie to be saved, the
renderer used in 3D View window, possible navigation paradigm, and specifying
triggers for recording a movie.

View

Lets you show or hide each of the toolbars or windows.

Command Button Purpose

Watermark Shows or hides the watermark. You cannot play the scene or explore it using
the navigating commands during a watermark preview.

Toolbars  Viewing toolbars. Locking toolbars in place.

Status Bar  Shows or hides the Cortona Movie Maker status bar.

Cortona
Console  Shows or hides the Cortona Console window which allows you to view events

during a scene preview.
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Camera

Controls for navigation modes, collider, headlight, and viewpoints.

Command Button Purpose

Navigation
Type

Allows you to select the navigation mode from a list of available navigation
paradigms.

Navigation
Style

Allows you to select the navigation style for the selected navigation mode.

Headlight Switches the headlight on and off. The headlight always shines directly in
front of the camera.

Collider Turns the collision detection on and off. By default Cortona allows you to pass
through objects in your path. To prevent from passing through objects in the
scene, you must turn the collision detection on.

Align Re-orients a camera if you have lost your way in a scene. Sets the camera's
horizontal and longitudinal axes parallel to the scene horizontal (XZ) plane.

Fit Makes the scene view fully visible in the 3D View window.

Viewpoints This allows you to select a viewpoint if it is specified in the scene.

Previous
Viewpoint

To move to the previous viewpoint (if possible).

Next
Viewpoint

To move to the next viewpoint (if possible).

Control

Commands for controlling the viewing mode in the 3D View window and recording a movie. 

Command Button Purpose

Play Runs the interpolators, sensors and scripts in the scene for the number of frames or
the time period specified in the "Series length" box. See Edit > Options > General
tab.

Play All The scene appears in the same way as if you were exploring it using a VRML
browser. This runs the interpolators, sensors and scripts in the scene indefinitely.

Pause This stops the interpolators, sensors and scripts in the scene and pauses recording.

Stop Stops all actions performed in the 3D View window of Cortona Movie Maker and the
recording the video file.

Record Prepares recording a movie. To start recording, click Play or Play All with the
Record button pressed.
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Go to
Time

 Opens the Go to Time dialog. It allows you to specify the time to which the scene
will be played and then stopped. The dialog also provides settings for the speed of
the scene playback. The scene always plays forward.

Reset Reloads the currently opened VRML scene.

Help

Lets you view the online Help system and general information about Cortona Movie Maker.

Copying Images

Edit menu > Copy

To copy the current image of the 3D View window to the Windows Clipboard:

•  On the Edit menu, click Copy, or use the shortcut keys Ctrl+C.

Go to Time

Control menu > Go to Time

In the Go to Time dialog you specify the time to which the scene will be played and then stopped. The dialog
also provides settings for the speed of the scene playback. The scene always plays forward.

To open the Go to Time dialog, do one of the following:

•  On the Control menu, click Go to Time.

•  Double-click the  Playback Position area on the status bar.

Position group

Desired position

Allows you to specify the time when the scene should be stopped after the playback (in hours, minutes,
seconds). It is not necessary to type in the full time format. For example, "10:" equals "0:10:0" and
"2:45" equals "0:2:45".

Current position

Displays the current playback position on the time line.

Time granularity group

The time granularity parameter specifies how often the simulation steps (frames) occur.

Use value from movie settings

Sets the time granularity parameter automatically in accordance with the frame rate for your output. The
time granularity parameter equals the time interval between frames (1000/FPS), in milliseconds per
frame.
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Manual

Allows you to specify the time granularity parameter manually in milliseconds per frame. When the time
granularity parameter is greater than the time interval between frames, it speeds up the scene playing,
otherwise, it slows down. This is useful if you want to move quickly to a time of your choosing.

Note

It is not recommended that you set the time granularity parameter greater than the minimal cycleInterval
of the TimeSensor node used in your VRML scene, otherwise, some events will not be generated
resulting in improper animation activities.

Editing with VrmlPad

Edit menu > Edit with VrmlPad

If ParallelGraphics VrmlPad (the authoring tool that allows you to design and develop professional VRML
content) is installed in your system, the Edit with VrmlPad function lets you send the currently opened VRML
scene to VrmlPad.

To send the current VRML scene to VrmlPad:

•  On the Edit menu, click Edit with VrmlPad.

Notes

•  If you have edited the scene using VrmlPad and then saved it, Cortona Movie Maker prompts you to
reload a scene for the new changes to take effect.

•  Unless ParallelGraphics VrmlPad is installed on your computer this command is absent from the menu.

Status Bar

The status bar is located at the bottom of the Cortona Movie Maker window. The left area of the status bar
describes the actions of menu items and toolbar buttons when you position the pointer over them.
Additionally the left area of the status bar displays the program status information. On the right you can view
the Recording Duration and Playback Position information boxes for what's opened in the Cortona Movie
Maker VRML file.

Area Purpose

The Recording Duration area displays the duration of the currently recorded movie (in
hours, minutes, seconds). If the bar is grayed out, the recording process is stopped.

The Playback Position area displays the current time (in hours, minutes, and seconds) in
the VRML world. Time (00:00:00.0) is equivalent to the moment when the Play or Play All
button is pressed for the fist time.

A watermark icon on the status bar. The image indicates whether or not to superimpose
the watermark on the movie or image. The icon of the disabled watermark turns gray.
Double-click the icon to turn Include watermark in movie setting on or off.
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The image of globe is animated during the transfer of the VRML or resource files if the
primary VRML file is opened from the Web.

The image of the disc drive is animated during the transfer of the VRML or resource files
if the primary VRML file is opened locally.

Watermark Preview

View menu > Watermark

The Watermark command from the View menu enters the Watermark Preview mode of Cortona Movie
Maker. You can display the current frame of your movie or image as it will look when created and change the
watermark position.

Note

You cannot play or explore your scene using the navigating commands in the 3D View window during a
watermark preview.

To change the position of a watermark

•  Make sure the Watermark check mark on the View menu is selected, position the pointer over the
image of watermark, press the left mouse button and move the mouse while holding down its left button
to the desired position.

•  Or click anywhere in the 3D View window to activate it and then use the shortcut keys.

Shortcut keys

Arrow Up move up

Arrow Down move down

Arrow Right move right

Arrow Left move left

Home aligns the top edge of the watermark with the top edge of the window

End aligns the bottom edge of the watermark with the bottom edge of the window

Shift+Home aligns the left edge of the watermark with the left edge of the window

Shift+End aligns the right edge of the watermark with the right edge of the window

PgUp move 16 pixels up at a time

PgDn move 16 pixels down at a time

Shift+PgUp move 16 pixels left at a time

Shift+PgDn move 16 pixels right at a time

Ctrl+PgUp decrease the degree of transparency

Ctrl+PgDn increase the degree of transparency
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See also

Watermark settings

Lock Toolbars

View menu > Toolbars > Lock the Toolbars

To lock toolbars:

•  On the View menu in Cortona Movie Maker, point to Toolbars, and then click Lock the Toolbars.

A check mark next to Lock the Toolbars indicates that the toolbars cannot be moved. To unlock the
toolbars click Lock the Toolbars again to clear the check mark.
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3D View Window

Overview

The main window in Cortona Movie Maker is called the 3D View window. 3D scenes or models are viewed
here. This window provides navigation paradigms (such as examine or flying) that enable the user to move
the viewer through the virtual world. You can navigate with the mouse, the keyboard, or both the mouse and
keyboard. ParallelGraphics Cortona VRML client is used as a viewer in the 3D View window.

Moving through a 3D space is similar to moving a camera. Think of a video camera that captures images in
the real world and converts them into electronic signals for viewing on a screen; it has a position and
orientation and these are independent attributes. Your movements in the world continually position and orient
that camera. Use the camera controls on the vertical toolbar to move the camera through the 3D Space.

This concept assumes that there is a real person viewing and interacting with the VRML world. Nevertheless
the VRML author may place any number of viewpoints (or cameras) in the world – in fact in any place from
which the user might wish to view the world. Though only one viewpoint may be active at a time.

Related topics about 3D navigation and setting 3D View window options.

Using Viewpoints
Moving around: Plan, Pan, Turn and Roll
Restore, Fit and Align
Keyboard commands
Renderer Settings
Navigation Settings

Using Viewpoints

A viewpoint describes a position and orientation for viewing the scene. The VRML author will probably want
to guide the user to the best vantage points for viewing it. Not all worlds contain viewpoints but when they do
you can use them.

To activate a viewpoint, do one of the following:

•  Click the arrow next to  Viewpoints in the Navigation Bar and then select a viewpoint from the list of
the predefined viewpoints.

•  On the Camera menu point to Viewpoints and select a viewpoint from the list.

•  To move to the next or previous viewpoint, use the  Previous Viewpoint and  Next Viewpoint
buttons, or Page Down and Page Up keyboard buttons.

•  If your mouse has a mouse wheel, roll the wheel with the Shift key pressed to move to the next or
previous viewpoint.

Note

If there are no predefined viewpoints in a world, the Empty message appears.
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Navigation Types: Walk

Walk+Plan

 and  
Use Walk+Plan to move in a horizontal plane.

Forward move closer

Backward move further

Right turn to the right

Left turn to the left

Note

Move the mouse forward or backward while holding down the Space key to turn upward or downward.
Move the mouse left or right while holding down the Alt key to move left or right.

Walk+Pan

 and  
Use Walk+Pan to move left or right in a horizontal plane.

Forward move closer

Backward move further away

Right move right

Left move left

Note

When you move the camera right or left the world will appear to move in the opposite direction.

Walk+Turn

 and  
Use Walk+Turn to change the angle of the camera in a world.

Forward turn upwards

Backward turn downwards

Right turn to the right

Left turn to the left

See also

Moving around: Walk, Fly, and Examine
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Navigation Types: Fly

Fly+Plan

 and  
Use Fly+Plan to move left or right.

Forward move the camera forward towards its longitudinal axis

Backward move the camera backward

Right turn the camera to the right around its vertical axis

Left turn the camera to the left around its vertical axis

Note

The camera's vertical axis may be inclined in a 3D Space.
Move the mouse while holding down the Alt key to switch Fly+Pan.
Move the mouse while holding down the Space key to switch Fly+Turn.
Move the mouse while holding down the Alt+Space keys to switch  Fly+Roll.

Fly+Pan

 and  
Use Fly+Pan to move up, down, left, or right within a single vertical plane.

Forward move up

Backward move down

Right move right

Left move left

Note

When you move the camera the world will appear to move in the opposite direction.

Fly+Turn

 and  
Use Fly+Turn to turn the camera.

Forward turn the camera upward around its horizontal axis

Backward turn the camera downward around its horizontal axis

Right turn the camera to the right around its vertical axis

Left turn the camera to the left around its vertical axis

Fly+Roll

 and  
Use Fly+Roll to incline the camera.

Right incline to the left
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Left incline to the right

See also

Moving around: Walk, Fly, and Examine

Navigation Types: Examine

Examine+Plan

 and  
Use Examine+Plan to examine an object from various angles.

Forward move the camera forward

Backward move the camera backward

Right
Left

move the camera around the central point which is defined by the center of the bounding box of
the geometry in the 3D scene.

Examine+Turn

 and  
Use Examine+Turn to examine an object from various angles.

Forward
Backward
Right
Left

move the camera around the central point which is defined by the center of the bounding box of
the geometry in the 3D scene.

Note

Move the mouse while holding down the Alt key to switch to Examine+Pan.
Move the mouse while holding down the Space key to switch to Examine+Plan.
Move the mouse while holding down the Alt+Space keys to switch to Examine+Roll.

Examine+Roll

 and  
Use Examine+Roll to incline the camera around the central point which is defined by the center of bounding
box of the geometry in the 3D scene.

Right incline to the left

Left incline to the right

Note

The VRML author can choose the rotation center in the EXAMINE navigation type. By default, when in
Examine mode, the 3D viewer sets the center of rotation in the center of the bounding box of the scene
geometry. But it is possible to change this center by specifying three additional values in the avatarSize field
of the NavigationInfo node. According to the VRML specification, the first three values are the avatar
dimensions, while additional values may be used for browser-specific purposes. In Cortona VRML Client
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(used as a 3D viewer) the fourth, fifth and sixth values specify the center of scene rotation in the world
coordinates X, Y and Z.

See also

Moving around: Walk, Fly, and Examine

Navigation Types: None

Use None to prevent navigation in the 3D View window.

See also

Moving around: Walk, Fly, and Examine

Restore, Fit and Align

There are three mechanisms that can help to re-orient a camera if you have lost your way in a world. Unlike
the navigation tools these buttons invoke predefined actions that take place as you click on them.

Click the Viewpoints button to automatically return to the loaded world's original active viewpoint.

Use the Fit button to make the scene view fully visible in the 3D View window.

Use Align to position the camera's horizontal and longitudinal axes parallel to the scene horizontal
plane.

Keyboard commands

You can control the camera using keyboard commands. The functionality for arrow buttons corresponds to
the movement of your mouse and depends on the navigation type and its style. Please note that the following
description of keyboard commands is presented for the Fly+Plan navigation.

Arrow Up move closer

Arrow Down move further away

Arrow Right turn to the right

Arrow Left turn to the left

Page Down next viewpoint

Page Up previous viewpoint
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The numeric keypad

Arrow Up move closer

Arrow Down move further away

Arrow Right move to the right. If in the Examine mode – move the camera around the center of
rotation

Arrow Left move to the left. If in the Examine mode – move the camera around the center of
rotation

Gray Plus move up in the case of the Fly mode

Gray Minus move down in the case of the Fly mode

1 incline to the right
Note: It is not available in the Walk mode

3 incline to the left
Note: It is not available in the Walk mode

7 turn the camera downward around its horizontal axis

9 turn the camera upward around its horizontal axis

The alphanumeric keyboard

1 incline to the right
Note: It is not available in the Walk mode

2 incline to the left
Note: It is not available in the Walk mode

3 turn downward. If the Examine mode – move the camera around the center of rotation

4 turn upward. If the Examine mode – move the camera around the center of rotation

To accelerate the camera's movement or rotation: Press Shift, Ctrl or Ctrl+Shift and one of the above keys
simultaneously.

The Alt and Space keys allow the user to quickly change the navigation option to Pan and Turn accordingly in
the Walk and Fly navigation modes (to Pan and Plan in the Examine mode). The Alt and Space keys
simultaneously pressed activate Roll in the Fly and Examine navigation types.
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Recording

Recording a Movie

Edit menu > Options
Control menu > Record, Play or Play All

To record a movie

1. Open the VRML scene that you want to capture for a recording.

2. On the Edit menu, click Options. You can control the recording procedure by specifying various
options.

3. On the General tab, specify the Series length and other settings you want.

4. On the Format tab, specify the file format for your movie and the compressor to be used.

5. On the Renderer tab, choose a rendering mode to draw the image in the 3D View window.

6. On the Watermark tab, you can place a watermark over the image.

7. On the Advanced tab, you can turn on the antialiasing filter for a better image quality, include the
mouse pointer in the 3D View capture, and define the event that triggers recording when the user clicks
in the 3D View window.

8. To prepare the program for recording a movie, click the Record button on the Standard Buttons toolbar
or mark Record in the Control menu.

9. To start recording, click Play or Play All and then specify the file name in the dialog box that appears.
The Play command allows you to play animation in the scene according to the Series length parameter
in the Options group of the Options dialog. The Play All command runs the interpolators, sensors and
scripts in the scene indefinitely.

10. To stop recording and close the video file, click Stop.

Note

If the Record button is released, the video file is not closed and it is possible to continue recording by clicking
the Record button again.

See also

Setting Program Options, Creating AVI Movies, Creating QuickTime Movies, Windows Media Movies, Tips
and Limitations

Capturing Images from 3D View

File menu > Export Image

The Export Image function lets you capture the part of your computer screen in the 3D View window for
further usage or editing. Images captured from the screen are commonly called screenshots.
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Creating Screen Captures

You have to setup the Program Options before you use the Export Image function. If you have started the
Export Image command, a dialog prompts you to save the image. In the Save as type drop-down box, click
one of the three file formats for your image.

You can also copy the image and put it into the Clipboard with the Copy command from the Edit menu.
Paste data in any drawing tool on the next step.

Creating AVI movies

This section describes how Cortona Movie Maker uses video codecs (compression/decompression) if you
choose to save your movie as an AVI file. The AVI file format retains the highest quality and is editable by
various video editing programs. The AVI file format is also a vendor neutral format that can be converted into
vendor specific streaming media file formats. These features make AVI files the ideal format for your original
high quality recordings.

Cortona Movie Maker gives you control over several codec settings. Files can be greatly reduced. However,
do keep in mind the trade-off between file size and quality. The more you compress, the more you reduce
quality. Generally AVI files are larger MPEG files. When making an AVI file, Cortona Movie Maker uses the
compressor (codec) you may choose at the Format tab in the Options dialog (see Edit menu > Options).

Codecs in Windows are used to play compressed files by decompressing them in memory. Adding a specific
codec lets Cortona Movie Maker create AVI files compressed in that file format. If the codec you want to use
is not listed in the Options dialog at the Format tab, it was not installed by Windows, or Cortona Movie Maker
cannot use it. Choose the compressor that is most suitable for your intended use. Depending on the codec
being used you can adjust the percentage of quality or data rate with the slider. The higher the percentage
you choose, the larger the resultant file.

The table lists the video codecs included with Windows and supported by Cortona Movie Maker:

Manufacturer Model

Intel Indeo R3.2 Video Codec

Microsoft Video codecs Video 1 Video Codec

SuperMatch Cinepak Video Codec

See also

•  Format Settings

•  DivX codecs: http://www.divx.com/software/

Creating QuickTime movies

QuickTime is a cross-platform movie file format with a wide selection of video and audio compressors.
QuickTime movies playback in the standard Apple QuickTime player on Windows and Mac computers.

Important

To enable MOV movies, install Apple QuickTime Player which is available on the Web page
http://www.apple.com/quicktime/download/. Be sure to include the QuickTime Authoring component (select
the corresponding check box) when you install QuickTime Player.
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Note

Depending on the compression options chosen, QuickTime (*.mov) movies made with Cortona Movie Maker
may not be playable on QuickTime players prior to version 4.0.

Creating Windows Media Movies

The WMV file format is the latest Microsoft streaming file format. With Windows Media you can save your
movies for streaming playback on the Web. You can share those movies with anyone around the world who
has the popular Windows Media Player software which is available free for the download from
www.microsoft.com.

Note

Windows Media Player version 7.1 (http://www.microsoft.com/windows/windowsmedia/download/) or a later
version should be installed on your computer.

Creating movies for RealPlayer (RealOne Player)

The RealMedia (RM/RMVB) streaming file format by RealNetworks gives content creators the ability to
stream any data type and uses the standard RealVideo codecs. Choose this file format for "real world" video
content with many color gradients, high motion, and where lossy video quality is acceptable.

Note

RealPlayer 8.0 (http://www.real.com/) or a later version must be installed on your system to play this format.
If you are asked if you would like to update your RealPlayer (RealOne Player), do so.

Tips and Limitations

Time-Dependent VRML Nodes

Because the creation of a movie frame may take some time, Cortona Movie Maker records the next frame
only when the previous one has been recorded. This approach enables the creation of high quality movie
without skipped frames but it does result in the corresponding delay in all time-dependent node execution. In
VRML, TimeSensor, AudioClip and MovieTexture are time-dependent nodes that activate and deactivate
themselves at specified times. When playing the VRML scene, Cortona Movie Maker slows down events on
the time scale only for those events used by the TimeSensor node and uses the real time scale for the two
last nodes. As a result, all animations based on the interpolators and scripts will be recorded correctly in the
resultant movie. If your VRML scene uses a time dependent texture contained in another movie file, its
starting, stopping time and duration may be changed in the movie you create. Additionally, if the VRML scene
uses events to trigger some animations from the events originated from AudioClip or MovieTexture nodes
(startTime, and stopTime exposedFields and the isActive eventOut), these animations will be played, started
and stopped at times on the real time line and because of time scaling during recording time intervals
between different actions may have changed.

Cortona Movie Maker cannot correctly play back VRML scenes involving an absolute-time event output from
the ECMAScript Date object to drive animation activities.

File Types for Watermarks

Portable Network Graphics (PNG) is a still-image file format developed for use with the Internet and World
Wide Web. Cortona Movie Maker supports PNG-8 and PNG-24 for input images to be used for watermarks.
Grayscale images are not supported.
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GIF is an 8-bit (256-color) format developed by Informix for the CompuServe® information service. It was
originally designed to minimize file transfer times over telephone lines. GIF is supported in Cortona Movie
Maker only as an input file format for watermarks.

The Frame Rate for Your Output

The frame rate of a movie is expressed in frames per second (FPS). You can get the time interval between
frames, in seconds, by dividing the unit by FPS. It is not recommended that you set the FPS value in such a
way that the time interval between frames becomes greater then the minimal cycleInterval of the TimeSensor
node in opened VRML scene. By ignoring this ratio the scene animation and behavior may not work as
desired.
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Setting Cortona Movie Maker Options

Setting Program Options

Edit menu > Options

You can configure Cortona Movie Maker options according to your preferences. By selecting the
corresponding option, you can control the process of creating a movie file, select a rendering mode in the 3D
and the image quality, choose navigation controls for viewing a scene and many others.

See also

General, Format, Renderer, Navigation, Watermark, Advanced

General Settings

On the General panel of the Options dialog you set options for the recording of a movie file.

Options group

Frame rate

Changes the frame rate for your output. It is expressed in frames per second (FPS).

Series length group

Specifies the video length that can be expressed in the frames or seconds.

Background color

Allows you to specify the background color for the image or video by changing the background color of
the 3D View window.

Frame size group

Width, Height

These allow you to specify the size of the frames. Note: Increasing the size of the video area increases
the amount of disk space required for recording and delivery but does not reduce the frame rate of your
videos.

Aspect

Aspect ratio describes the proportions of a still image or the frames in a movie, expressed as the ratio of
width to height (for example, 4:3).

Output folder

Lets you choose the folder where all files from Cortona Movie Maker should be placed. To save files in a
different folder, click the Browse button to search for the gallery folder, and if you want to create a new
one, click New Folder.
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Format Settings

Lets you specify the type of file you are saving. When you render the VRML scene to an AVI file, you have
the following file Setup options: the compression algorithm and the quality and compression level.

Output format

Lets you choose the file format to save a video file or an image sequence.

Compressor

Select the codec (compressor/decompressor) you want to use to compress the file. The codecs available
depend on the selected Output format. Cortona Movie Maker supports Cinepak, Intel Indeo 3.2, Microsoft
Video 1 and other codecs that are included with Windows. You can also render uncompressed frames (and
then use an external application to compress the file).

Quality

Use the slider to select the quality you want. The higher you set the quality, the larger the file size will be.

Key frame every N frames

Select the interval between the Delta keyframes used to compare one frame with another and generate in-
between frames. Too large an interval will create a loss of quality in the AVI file as a whole.

Configure

Click this button to see any additional options specific to the currently selected codec.

Default

Restores the quality to its default value.

Renderer Settings

Allows you to select a rendering mode. To draw the 3D image, Cortona Movie Maker uses Cortona VRML
client that in turn provides two hardware renderers: OpenGL and DirectX. If your system has hardware
acceleration for either OpenGL or Direct3D (note: you must have DirectX 5 or greater installed), choose the
appropriate renderer. Using hardware renderers can introduce limitations. Select a renderer to compare the
performance and visual quality of hardware versus software rendering and set your preferences accordingly.

Renderer options

Dither colors if needed

Controls whether Cortona dithers while rendering. Dithering improves the quality of rendering but may lower
performance.

Motion blur effect

Apply a motion blur effect. This actually makes an image seem a little blurred in motion.

Wireframe rendering mode

The object appears to be outlined with wires rather than a solid.
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Anti-aliasing

The technique for smoothing out jaggies in showing curves on a computer monitor. There are two different
modes: Idle-time and Real-time. If the Idle-time option is on, it is only applied for a static scene. But selecting
Real-time initiates smoothing, even in the viewer movement, but results in a decreasing frame rate.

Do not render textures

To turn the textures on or off.

Limit textures size

All textures are optimized for speed.

Optimize texture for quality

All textures are optimized for quality. Note that if you select both Optimize texture for speed and quality the
renderer uses the available resources to optimize speed and quality simultaneously.

Use textures mip-mapping

When the scene contains acutely angled polygons that disappear into the distance, it mixes low and high-
resolution versions of the same texture to reduce the jagged effect.

Advanced alpha blending

Alpha blending is the name for the alpha channel control and it's used to simulate effects such as placing a
piece of glass in front of an object so that the object is completely visible behind the glass or unseen, or
something in between. Advanced alpha blending turns a particular rendering method on for better quality of
translucent faces. The processor should support MMX additional instructions.

Automatic level of detail

Automatically reduces the number of polygons which are displayed for any object at large distances (tiny
objects on computer screen) from the viewer.

Extended Z-buffer

If the check box is selected this sets the 32-bit Z-buffer for the software renderer (R98). The default is 16-bit.

Phong lighting model

A particular method for computing the apparent color of a face at a particular point. It improves the quality of
lighting but lowers performance. Note that this option is available only for R98 Renderer in the Intel Pentium
III optimization mode.

Realistic fog

A method for computing the color for every pixel in the frame buffer to simulate fog. It improves the quality but
lowers performance.

Optimization

Turns the optimization rendering mode on or off, if possible.

Renderer version

This is accessible only for Direct3D renderers. Allows you to select a Revanche DX5 rendering mode in the
case you have DirectX 7 or a later version installed.
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Navigation Settings

Navigation mode

This allows you to select the navigation mode from a list of available navigation paradigms.

Travel speed

Sets the rate at which the viewer travels through a scene. The following are the typical values for the rates, in
metres per second: Slowest=0.0625, Slower=0.25, Normal=1, Faster=4, Fastest=16. If the speed field of the
NavigationInfo is specified in the VRML file, the corresponding speed factors are multiplied.

Animate viewpoint

Sets the Viewpoint transition rules that specify how Cortona interprets the transition from the old viewpoint to
the new one. Auto – defined by the jump field of the Viewpoint node of a new location. Always – a jump with
the transition effect. Never – instantaneous transition.

Collision detection

By default Cortona (used as a 3D viewer) will allow you to pass through objects in your path. To prevent from
passing through objects, select Always in the Collision detection box at the Navigation tab. Select Auto to use
the collision method specified by VRML author.

Headlight on

Mark the check box to turn the headlight on.

Show hidden viewpoint

This allows you to see all viewpoints of the scene in the Viewpoints list including those that do not have a
description (Viewpoint's description field is empty).

Watermark Settings

A watermark is any graphic that appears on top of the created movie or image.

Include watermark in movie

When selected it adds the watermark specified in the Image path box to a movie or image.

Image position

In the Left and Top boxes, enter the position for a watermark in the range from -4200 to 4200 in pixels. The
coordinates are relative to the upper-left corner of the Cortona Movie Maker window. You can also move the
watermark by dragging in the Watermark Preview mode.

Opacity

The Opacity slider control specifies how "clear" a watermark is from completely transparent to completely
opaque.

Image path

Provides a space for you to type the full path of an image file you want to use as a watermark. You can also
open an image on your computer hard disk or on a network drive that you have a connection to by clicking
the Browse button.
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Advanced Settings

Apply antialiasing filter

This allows you to turn on or off the technique for smoothing out jaggies in showing curves on the frames of
you video and images. When selected it produces a smooth-edged image by partially filling in pixels along
the edge making them semi-transparent.

Capture mouse cursor

When selected it adds the mouse pointer to images.

Start recording by clicking in the 3D View

By default, Cortona Movie Maker starts capturing images when you click either the Play or Play All button
with the Record button pressed. If you mark this check box, the recording will be started as a result of the
user click in the 3D View window.

Do not pause recording when loading resources

If the VRML scene contains paths to the resources, for example, textures, the recording is stopped until all
resources are loaded. To prevent pausing, mark this check box.
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